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PREFACE 
 
 

In the fall of 2009 the Florida Department of Transportation’s State 

Materials Office (FDOT-SMO) in Gainesville, Florida, approved a grant to 

develop an appropriate method of “Use of Scanning Electron Microscopy and 

Microanalysis to Determine Chloride Content of Concrete and Raw Materials”. 

The method was to be developed at the Major Analytical Instrumentation Center 

(MAIC), one of the research service centers within the University of Florida’s 

College of Engineering under contract BDK75 977-15. FDOT-SMO would provide 

standard cementitious samples and evaluate the potential of the method to 

augment and/or replace the analytical techniques currently practiced by FDOT-

SMO for analysis of chloride in cementitious materials. An electron microscope-

based method has significant advantages and the motivations for the contract 

were clear: 1) automated and non-destructive sample analysis, 2) generation of 

never-before seen quantitative microscopic images of the chloride distribution 

over large areas (cm2) of sample materials and 3) minimization of both the use of 

harsh chemicals and generation of hazardous wastes.  It was further hoped that 

this electron microscope-based method could more rapidly determine the 

diffusivity of chloride ions through cementitious samples, thereby increasing 

sample throughput and helping FDOT-SMO meet its goals and mission. With 

these common goals, analytical project work began in 2009.  
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EXECUTIVE SUMMARY 
 

 
Chloride (Cl) content was analyzed using x-ray analysis techniques (XRT) 

in cement, mortar and concrete samples subjected to Cl diffusion, and the results 

were compared with analysis done using wet chemistry (WC).  The two XRT 

used were Scanning Electron Microscopy (SEM) – Energy Dispersive 

Spectroscopy (EDS), and Electron Probe Microanalysis (EPMA) – Wavelength 

Dispersive Spectroscopy (WDS). Cement and mortar samples with known levels 

of Cl were measured and used as a reference for the XRT quantitative 

measurements. The XRT allowed the construction of quantitative distribution 

maps of Cl for the concrete samples.  From the quantitative Cl distribution maps 

diffusion profiles were created comparing WC and XRT data. Finally, diffusion 

profiles were generated and Cl diffusivity (Da) was evaluated in all the concrete 

samples. The obtained diffusivity values were compared to the values 

determined by WC. 

The analysis of the samples in this study took approximately 8 hours using 

the SEM-EDS and 30 hours using the EPMA-WDS.  The size of the areas 

analyzed in the samples was the largest we were able to accommodate with the 

instruments used. It is expected that the analysis of smaller areas could improve 

analysis time without significant loss of accuracy. Both SEM-EDS and EPMA-

WDS consistently over-predicted the Cl concentration at a given depth in the 

samples as compared to WC. This result indicated that better reference samples 

are needed to be used for XRT. When one of the concrete samples was used as 

a reference, absolute concentrations measured with the x-ray analysis 

techniques were more similar to those determined by WC.  The evaluation of a 

standardless determination of Da values was also conducted and applied to all of 

the concrete samples. This resulted in Da values that differed from WC results by 

a maximum of 6.8% and 4.4% for SEM-EDS and EPMA-WDS, respectively.  

Thus, these XRT have the potential to become a streamlined approach for 

rapidly determining Da values at the same time bringing the advantage of 

providing detailed data on the spatial distribution of Cl in the sample. 
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CHAPTER 1 
INTRODUCTION  

 
 
Background 
 
 

Cement and cement-based materials like mortar and concrete are among 

the most commonly used construction materials worldwide. Known to the 

ancients, cement, the essential binder in cementitious materials, is composed 

mainly of anhydrous minerals called calcium silicates that, when mixed with 

water, react and are converted into various calcium silicate-hydrate crystalline 

minerals. During curing/setting, all of the various hydration reactions of the 

minerals form and grow crystals that are entangled and intertwined with the other 

crystals to ultimately produce a rigid material. Because the various hydration 

reactions of the several anhydrous minerals are rarely complete at the time the 

material is considered rigid and cured, cement based materials may continue to 

harden over the course of many years. Hence in a very real sense, cementitious 

materials are a sort of dynamic material.  

 

Objects and structures are rarely made solely of cement due to cost and 

materials properties, thus composites are therefore common. Mortar (cement 

combined with sand) and concrete (cement combined with sand- fine aggregate 

rock- large aggregate and other additives like fly-ash, slag, etc.) are the most 

common and important. Concrete is used frequently as a major structural 

element in the construction of bridges, roads and buildings. Typically and 

depending of the specific formulations, concrete has excellent compressive 

mechanical properties, but is poor in tension, torsion and bending. Concrete is 

therefore reinforced with steel bars (rebars) to circumvent these limitations in 

mechanical properties.   

 

Due to the porous nature, structure and composition of cement and 

concrete, they are permeable to water and ions. This characteristic of concrete 
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can have important consequences on the life time or durability of reinforced 

concrete structures. It is especially important for structures like bridges and roads 

in water environments with significant concentrations of chloride. Over time, 

chloride ions are known to diffuse through the pores and paste component in 

sufficient quantities to depassivate the surface of the steel rebar and 

initiate/facilitate rebar corrosion. The main difficulty associated with this type of 

corrosion is not the loss of strength of the rebar as one might initially suspect, but 

rather the effective increase in the rebar volume due to the rusting of its surface. 

The rusty iron phase has a larger volume than its parent iron phase; the rebar 

begins to swell and exert a pressure/force inside its rigid concrete container. If 

oxidative conditions persist and the rebar corrosion goes unchecked, the 

concrete will eventually cracks and spall, potentially further exposing the rebar to 

corrosive environments.  

 

The Florida Department of Transportation (FDOT) has a deep interest in 

monitoring chloride ions diffusion in cement and concrete structures as it has 

many at-risk structures under its upkeep given the unique Florida environment. 

Ideally FDOT would like to get 75 years out of a structure before major repair, 

remediation or outright replacement. As chloride-based attack corrosion is a 

central issue impacting structure durability for FDOT, an in-house chloride 

monitoring system has been developed and put in place and maintained by the 

FDOT through their state materials office (SMO) located in Gainesville, Florida. 

Samples that have been cored from structures like bridge piles and foundations 

in chloride-rich aqueous environments are routinely analyzed and profiled by 

FDOT-SMO to assess structure durability and develop chloride-remediation, and 

repair plans and strategies.  

 

The basic analysis starts by sectioning one of the cored samples at 

regular thicknesses (often ¼” = 6.35 mm.) starting the exposed surface to the 

rebar-concrete interface. The sections are then pulverized and digested using 

nitric acid and the resulting solution titrated with a standardized silver nitrate 
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solution to determine the total chloride content. The titration endpoint is 

determined potentiometrically via a silver/chloride selective electrode. Although 

this method is extremely accurate and sensitive for the measurement of total 

chloride ion content in the slices, it is time consuming and arduous, destroys the 

sample, yields only one data point per slice, has poor spatial resolution and 

provides no information about the in situ spatial distribution of chloride ions in the 

sample.  

 

Statement of Hypothesis 

 

A non-destructive, high spatial resolution method of Cl analysis that 

provides spatial distribution of Cl in the sample, concentration profiles and 

diffusion coefficients can be developed using electron beam instrumentation and 

corresponding x-ray spectroscopy techniques. 

 

Objectives 

 

1. Characterize the microstructure, and Cl elemental composition in the 

cement paste and concrete samples. 

2. Develop a reliable and reproducible method to determine, quantitatively, 

the chloride ion concentration in cement paste, and concrete samples with known 

chloride ion concentrations using x-ray microanalysis techniques. 
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CHAPTER 2 
LITERATURE REVIEW 

 

Review of previous research 

 

Two previous studies are key background for the microprobe portion of the 

microanalysis in this study: “Chloride Ingress Profiles Measured by Electron 

Probe Micro Analysis” by Jensen et al. [5], and “Application for Electron Probe 

Microanalyzer for Measurement of Cl Concentration Profile in Concrete” by Mori 

et al. [6]. 

 

In the Jensen study [5], the e-beam was scanned (stage scanned we 

assume) in lines (linescans) on a concrete sample surface from the chloride-

exposed edge to a depth of 25 mm. normal to the exposed surface. Chloride 

concentrations were reported as counts of Cl x-rays. The lines consisted of 250 - 

1000 points per line with a dwell time of one second per point operating in what 

the authors called “qualitative measurements” mode. The linescans presented for 

samples subjected to Cl ingress with water/cement (w/c) ratios = 0.3 showed a 

decreasing profile in counts as a function of depth from the exposed surface. The 

data in this study is still raw, but demonstrates that electron probe microanalysis 

(EPMA) can be used to generate a Cl profile in concrete samples. The authors 

also determined that epoxy used to fill pores and cracks in the sample can have 

a detectable level of Cl. Use of standard epoxies in sample preparation should 

therefore be avoided if possible.  

 

Mori et al. [5] conducted a more extensive study and used the EPMA to 

generate large scale (cm2) quantitative x-ray maps. These authors used a stage 

rastering method to collect large-pixel-array (>105 pixels) x-ray-map images of 

cement and concrete samples. By using an extremely short dwell time of 40 

ms/pixel, large maps could be collected in manageable time frames. These 

authors also determined that using a defocused probe (50um in diameter), 100 

nA probe current, 15 KeV accelerating voltage, a pixel size (step size) of 100 μm 
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yielded a high-quality quantifiable elemental distribution (x-ray map). Cement 

standards with known levels of Cl (0, 0.5, 1.0, 2.0, 3.0, 4.0, 5.0 wt. %) were also 

mapped and used to construct linear calibration curves of counts (normalized to 

probe current) as a function of Cl concentration.  

 

The instrument used in this study was an EPMA equipped with four 

spectrometers to collect the elements (singly): Cl, Ca, Si, and S. A gating 

strategy based on the Ca/Si/S ratio determined for each pixel was used to 

determine which pixels corresponded to aggregate or paste. This strategy 

allowed for the discrimination between paste and aggregate. A main thrust in the 

Mori et al. work is that Cl ions diffuse mainly through the paste component of 

concrete and mortar and minimally through the aggregate components. 

Quantifying only the Cl in the paste pixels produced Cl concentration/diffusion 

profiles that essentially matched those obtained through the sectioning/grinding 

and wet chemistry method used in Japan. Calculated average diffusion 

coefficients (Da) obtained from the Cl paste-only maps of 0.5 w/c concrete 

samples were the same as those obtained for the wet-chemical analysis of 

similar samples. This correspondence was also maintained for 0.4 w/c samples, 

however the data point reported for the 0.3 w/c sample was significantly higher 

than that determined from the wet chemistry data. In light of these results, the x-

ray mapping method appeared to be highly effective using the indicated 

instruments by these authors.  

 

Summary of state-of-the-art 

 

The scanning electron microscope (SEM) used for microanalysis is 

equipped with an energy dispersive spectroscopy (EDS) system and an electron 

probe micro-analysis instrument (EPMA) equipped with a wavelength dispersive 

x-ray spectroscopy (WDS) system was also used. In these instruments, a beam 

of electrons (e-beam) is generated at the top of a column (electron gun) by a 

source (filament) (Figure 1) [1], a high potential anode just below the source is 
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strongly positively biased accelerates source electrons down the microscope 

column. A series of electron lenses in the column “steer” these accelerated 

electrons down the column and ultimately onto a very fine point on a sample 

placed on a stage inside of a large chamber. The entire system (gun, column and 

sample chamber) is maintained under high vacuum conditions essentially to 

maximize the mean free path of the beam electrons and the electron signal 

coming out of the sample (Figure 2) [1].  

 

 

 

 

Figure 1 Major parts and components of the SEM [1] 
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Figure 2 Schematic drawing of the microscope column showing the 

electron gun, lenses, deflection system, and electron detector [1] 

 

Several physical phenomena occur as the electrons of the beam interact 

with the atoms of the sample, and multiple signals are generated. These different 

signals can be broadly categorized into two types: electrons and “light”. In the 

electron category, secondary electrons (SE) are a type of signal composed of 

low-energy, trajectory independent electrons produced by the sample 

subsequent to e-beam impingement which provide topographic information about 

the sample surface that allow for construction of microscopic images of the 

sample surface.  
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Figure 3 Schematic drawing of the electron beam sample interaction [2] 

 

Backscattered electrons (BSE) are beam electrons which have undergone 

an elastic interaction with the sample surface, and have experienced a high 

angle (≈180°) change in trajectory. Thus, these electrons are scattered back 

towards the beam source. This signal contains a limited amount of topographic 

information but is extremely sensitive to the average atomic number of the 

sample surface, a type of compositional information.  

 

Finally, a certain number of beam electrons will essentially be conducted 

by the sample to ground (Figure 4) [3], and this measurable current is termed 

specimen current (SC). The SC signal reflects changes in both the SE (due to 

topography) and BSE (due to compositional variations) signals and can therefore 

be used to construct microscopic images of a sample surface which contain both 

topographical and compositional information.  
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 Figure 4 Schematic drawing showing specimen current (adapted from [3]) 

 

In e-beam instruments like the SEM and EPMA, resolution should not be 

confused with magnification. Resolution is largely decoupled from magnification, 

unlike in optical microscopy. Hence, it is possible to have higher and higher 

magnification images of a region of interest (ROI) with no increase in resolution, 

a phenomenon known as empty magnification. The resolution in an e-beam 

instrument is determined by the minimum spot size of the electron probe (dp) and 

the dimensions of the interaction volume (Figure 9) [4] created when an electron 

probe impinges on a sample surface.  
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Figure 5 Schematic drawing of the interaction volume [4] 

 

The interaction volume is nominal tear-drop or pear shaped with a lateral-

spatial diameter of ≈1μm. Secondary electrons have very low energies (≤ 50 eV) 

and consequently are only able to escape from the first few nanometers of the 

sample surface. They are very sensitive to the sample surface topography and 

are therefore, used to construct high-resolution (<10 nm) topographic images.  

 

Backscattered electrons have energies on the order of the e-beam probe 

(KeV) and can therefore escape from much deeper portions of the interaction 

volume. Also, due to their much higher energy BSE can emanate from areas 

much farther away from the beam impact point compared to SE and 

consequently can be used to construct images with far more limited resolution.  

 

The characteristic x-ray signal can originate from regions much more 
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deeper of the sample compared to the BSE signal and can only be used to 

construct images with a nominal resolution close to the dimensions of the 

interaction volume (≈1μm). In summary, while the SE signal can be used to 

construct images of the sample surface topography with resolutions of <10nm, 

the BSE and characteristic x-ray signals can be used to generate compositional 

images with lower lateral-spatial resolutions, much poorer than that of SE 

images. Finally, given that the average atomic number of cementitious materials 

is of relatively low atomic number (Z) (compared to say a pure metal or alloy); the 

resolution of compositional images of these materials is likely worse than ~1μm.  

 

The other most important signal generated from e-beam-sample 

interaction is “light” in the form of x-rays. The x-rays are both continuum and 

characteristic; the continuum x-rays are produced via deceleration of beam 

electrons as they experience coulombic interactions with the electron clouds and 

nuclei of sample atoms and can therefore have any energy up to that of the 

beam energy. These x-rays do not provide information about sample 

composition.  

 

Characteristic x-rays are generated by inner electron shell ionization of 

sample atoms by the e-beam; the ionized atoms undergo a relaxation process in 

which electrons from higher shells drop down to fill the voids left in inner-shell 

ionizations. This transition from “high” shell to “lower” shell is accompanied by the 

emission of an x-ray of a specific energy, characteristic of the type of shell-to-

shell transition. The energy, wavelength and pattern of these transitions are very 

unique to each element and can therefore be used to identify and quantify the 

element composition of the sample surface interacting with the e-beam.  

 

Most elements actually emit an associated family of x-ray lines with 

increasing amounts of lines for increasing numbers of electrons and electron 

shells. A specific line of the family of lines emitted from one element can overlap 

with a line of other element thus complicating the unambiguous identification and 
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quantification of elements present in complex samples. These lines have been 

extensively characterized over the years and are commonly available in built-in 

electronic identification tools.  

 

In an EDS system, x-rays emitted from the sample with an appropriate 

trajectory are collected by a small diameter biased disc of SiLi (silicon-lithium) 

diode cooled by liquid nitrogen (Figure 6) [1]. The x-rays create electron-hole 

pairs in the SiLi diode detectable as a voltage; the number of hole-pairs i.e., the 

voltage is proportional to the absorbed x-ray. Through a series of electronics and 

processing, single x-ray absorption events (voltage pulses) can be quantified and 

displayed in a spectrum of counts as a function of energy (usually KeV). Indexing 

(assigning the peaks in the spectrum) allows for identification of the elements in 

the ROI.  

 

Figure 6 Schematic representation of an energy-dispersive spectrometer 

and associated electronics [1] 

 

In a WDS system sample-emitted x-rays with appropriate trajectories enter 

the detector. They impinge first on a near-prefect crystal with a specific d-spacing 

and orientation. X-rays with specific wavelengths hitting the crystal at Bragg 
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angles are diffracted at known angles. A simple gas-filled detector (gas 

proportional counter) placed at a specific position with respect to the crystal and 

the sample, called Rowland circle geometry, serves as an x-ray detector (Figure 

7) [1].  

 

The detector has a wire with a strong positive bias; incoming x-rays ionize 

the gas; the electrons produced are accelerated toward the positively biased 

wire. These electrons produce a wave of secondary ionization and all of these 

electrons are collected by the wire and generate a current in the wire that is 

converted into voltage pulse. This detector is tunable, with the crystal acting as a 

sort of x-ray band pass filter (Figure 8) [1]. 

 

 

 

 

Figure 7 Schematic drawing of a gas flow proportional counter [1] 
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Figure 8 Schematic representation of a wavelength dispersive spectrometer and 

associated electronics [1] 

 

The WDS system has higher spectral resolution (~5eV) than the SiLi 

diodes employed for EDS. Because probe currents orders of magnitude greater 

than that used for EDS are required, WDS x-ray count-rates are much larger. 

Both of these strengths contribute to the 10 times order of magnitude improve- 

ment in the lower limit of detection for many elements (particularly low atomic 

number elements) compared to EDS. In WDS collections, great care is given to 

maintain the beam normal to the sample surface and for making the surface flat 

via polishing, with a mirror finish and average surface roughness of 1μm. 

 

 Keeping the beam normal to the surface maintains the Rowland circle 

geometry; average roughness orders of magnitude greater than this have an 

impact on the detected signal, resulting in poorer limits of detection. These same 

issues are important to quantitative EDS, however, most EDS collection are 

typically semi-quantitative at best.    
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It is important to understand the digital nature of all image data generated 

from an SEM or EPMA. All these images are essentially signal intensity maps; 

the maps are composed of picture elements (pixels) which link the signal 

intensity at a physical location on a sample surface with a position in the image 

(figure 9) [1]. To create an image, the electron beam is addressed to a specific 

spot on a sample for a finite length of time (dwell time) and the various signals 

are detected and counted. Following a pattern of predetermined rows and 

columns, the beam is addressed to another spot on the sample and the signal 

intensities recorded. This process is repeated until the entire array has been 

covered.  

 

In both the SEM and EPMA, the beam itself can be scanned to each spot 

of the pattern, or the sample can moved under a fixed beam essentially normal to 

the surface. Imaging a relative small area (several hundred μm2) can be 

achieved by scanning the beam. However, since the beam can only be deflected 

through a small distance, imaging of large areas (mm2 and cm2 in area) requires 

the stage to move, so called “stage rastering”, to cover each spot/pixel in the 

array.  

 

Magnification in this type of imaging follows the relationship of scan 

area/screen area. Dimensions and numbers of pixels on the video 

screen/monitor, in our instruments a cathode ray tube (CRT), or captured digital 

image are constant. The number of pixels and their relative lateral-spatial 

relationship with each other matches those of the CRT (1:1 correspondence); 

however, the pixel dimensions resulting from scanning the beam in an array on 

the sample surface change depending on the length and width of the scan array. 

Therefore, if for example it is assumed that the typical CRT pixel dimensions are 

100 μm x 100 μm and the typical screen size is 10 cm. x 10 cm., scanning the e-

beam on the sample surface in the 1:1 scan array with pixels 10 μm x 10 μm in 

size yields a scan area of 1cm x 1cm and a resultant magnification of 10X. 

Higher and higher magnifications (up to 1,000,000X in some of today’s best 
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instruments) can be achieved by scanning increasing smaller areas composed of 

increasingly smaller scanned pixels.  

 

 

Figure 9 Principle of image display by area scanning [1] 

 

X-ray maps consist on arrays of pixels (dots) that indicate the presence of 

a specific/selected element in a specific location on the sample, typically 

corresponding to the size of the interaction volume. The maps, usually qualitative 

in nature, provide an element distribution across a ROI that can be overlapped 

with topographical (SE) or compositional images (BSE). 
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CHAPTER 3 
METHODOLOGY 

 

Experimental Design 

 

All samples studied in this report were prepared and received from FDOT-

SMO. This report was focused on two standard series called 1-series and CFS-

series, and the three provided concrete samples from FDOT-SMO Cl ion 

diffusion experiments: B-15, E-15, and I-15. All samples were saw cut by FDOT-

SMO with a large tile saw. 1-series consisted of 13 samples of cement-only (w/c 

= 0.3) mixed with known amounts of NaCl in an added concentration range of 

0.01 – 1.0 wt. % Cl. The CFS series consisted of 13 samples that were cement 

(w/c = 0.3) containing a constant amount of fly-ash and sand plus known 

amounts of NaCl ranging from 0.01 – 1.0 wt. % Cl.  The data corresponding to 

the 1-series and the CFS series can be found in the appendix (Tables 2 and 3).  

 

All samples in both standard series were initially cast into cylindrical molds 

(10.16 cm length, 4.32cm diameter). After pouring into mold samples were 

spinned for the first 24 hours. Samples were cured additional 27 days in the mold 

and then demolded. The total cure age was 28 days. After demolding the 

samples were sliced removing two one inch (2.54 cm) sections, one from the top 

and one from the bottom (see figure 10a), leaving the middle section to be used 

in this study. The samples were then bifurcated parallel to the cylindrical axis to 

produce two samples with rectangular fronts and half-cylinder backs (figure 10b). 

 

The rectangular face of each standard then needed to be ground level 

(down past any marks or damage left by the saw) using a very course polish 

paper and polishing wheel or a grinding stone. Each standard then need to be 

polished to a mirror-finish (scratches < 1μm) or as close as possible to satisfy the 

geometrical constraints described above. 
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(a) 

 

 

(b) 

 

Figure 10 (a) Sectioning of cement samples, (b) Cement samples with 

rectangular fronts and cylindrical backs (scale bar 2.54 cm) 

 

The rectangular face of each standard then needed to be ground level 

(down past any marks or damage left by the saw) using a very course polish 

paper and polishing wheel or a grinding stone. Each standard then need to be 

polished to a mirror-finish (scratches < 1μm) or as close as possible to satisfy the 

geometrical constraints described above. Because they consisted only of cement 

and were relatively soft, 1-series standards were polished by hand at MAIC using 

a Buehler polish wheel and polish papers over a range of grits down to < 1μm. 

The very first samples were polished using kerosene as lubricant; use of water, 

some alcohols and acetone should be avoided as these can solvate Cl and leach 

Cl form cementitious sample surface and bulk.  
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However, polishing in kerosene had many drawbacks and permanently 

impregnated the samples with kerosene, so its use was quickly abandoned in 

favor of a draw-polishing method. In this method, still conducted under a fume 

hood, no lubricant was used. Instead, the polishing papers were replaced more 

frequently and debris on the samples was cleared using regular blasts of 

compressed nitrogen or argon from a triggered hose nozzle. Dust was regularly 

cleaned up with water, damp paper towels, and put into a covered waste bucket 

for environmental health and safety (EH&S) disposal; polishing papers were also 

soaked in water before disposal to maximize dust containment and minimize dust 

exposure. Though this method yielded excellent 1-series samples, it was 

extremely time consuming and not cost effective. It could also not be used for the 

CFS series or any of the experimental samples as they were much harder than 

the 1-series samples and destroyed or could otherwise not be polished by hand 

using a wheel and paper.  

 

All other samples were therefore sent to American Petrographic Service, 

INC. (APS) (St. Paul, MN), and were prepared and polished by Christopher 

Owen. Among other services, APS has dedicated sample preparation facilities 

including robust sample preparation instruments such as large stone grinding 

wheels and dust scavenger systems.  The experimental samples B15, E15, and 

I15 were cut into rectangles by FDOT-SMO, and were then polished by APS.  

 

The sample preparation methodology used by APS is as follows: 

 Samples are received and unpacked. 

 Approximate dimensions of sample batch are recorded. 

 Sample identification is observed and labeling of samples is confirmed or 

applied, if necessary. 

 A dry, magnetic, diamond abrasive mat is applied to a lapidary wheel. 

 Wheel is engaged. 

 Sample is held, saw-cut surface down, on the abrasive surface. 

 Compressed air is used as needed to clear dust build-up off abrasive mat 
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and sample surface. 

 Sample is ground with progressively finer abrasive mats until a smooth 

matte finish is achieved. Grits used: 80, 220, 600, 1200 

 Compressed air is again used to clear dust build-up off sample surface. 

  Once all samples are polished, they are re-packaged in clean bags and 

shipped to University of Florida for examination. 

 

All samples (standard and experimental) were blown off with compressed 

gas and stored in vacuum desiccators at a rough vacuum. The samples were 

stored for at least two weeks under this vacuum which removed water resulting 

essentially in drying the sample surfaces. Before any sample was properly 

analyzed by either the SEM or EPMA, the surface to be analyzed was rendered 

conductive. This was required because a significant portion of the e-beam is 

deposited into the sample and charge builds up in the sample if the analyzed 

surface is not conductive and a good path to ground (instrument stage) is not 

maintained.  

 

For high dielectric (non-conductive) materials like cement and concrete, a 

thin conductive film (typically carbon or gold) coating is applied to the surface to 

be studied. For x-ray studies, carbon is used because it does not generate x-rays 

that overlap the x-rays of interest from the sample. All samples were coated as 

follows: using conductive carbon paint, a ≈ 6mm. thick border was painted on all 

the edges of the polished surface and then all the way down to the corresponding 

four sides. Once all the paint had dried in open air, the sample was placed into 

the bell jar of an evaporated-carbon sample coater. After achieving a high 

vacuum in the bell jar, a high current was applied across a thin carbon rod which 

generated an arc, thereby evaporating the carbon rod. A thin amorphous layer of 

carbon deposits on everything (including the polished sample surface); the 

sample is additionally rotated in the chamber during arcing to achieve a more 

uniform sample coating. Once coated, samples were ready to be loaded into the 

instruments. It is important to mention that the use of epoxy-impregnation was 
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completely avoided for all samples; though there are purportedly low Cl epoxies 

available, they are expensive and not widely available. Finally, epoxy 

impregnation provides only a dubious advantage, at best, to improving the quality 

of the analysis.   

 

Equipment 

 

The scanning electron microscope used in MAIC was a JSM-6400 

equipped with an Oxford Link Isis imaging-EDS hardware, and Windows software 

as well as a Deben Sprite 2-axis (X and Y) programmable motorized stage. In 

order to conduct large scale SEM x-ray mapping studies, a custom piece of 

Windows software interfacing the Deben Sprite programmable stage and the 

Oxford x-ray mapping software was needed and written by Richard Deist.  

 

The EPMA used was a SuperProbe JSM-733 equipped with a Tracor-

Northern WDS hardware and custom (non PC) software package including a 

programmable motorized 3-axis stage. Collection of large-scale x-ray maps from 

the microprobe was more complex and also required custom Window-based 

software to be created. All custom software and macros created for this project 

are provided in a supplemental electronic file archive. 

 

Procedures 

 

For SEM-EDS the size/pattern of the large-scale collection was 

programmed using an A-Stage and an array (< 200) of x-ray maps (50X) were 

collected using the speedmap feature in the Link-Isis software. The elements 

collected for mapping were predefined by custom energy windows created over 

discrete energy ranges (KeV) on the EDS spectrum. Forty repeated frames were 

collected simultaneously for each element of interest including silicon (Si), 

calcium (Ca), chlorine (Cl) and aluminum (Al); and a backscatter image was also 

collected for each spot in the mapping array.  
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After completing a full collection on a sample (≈8 hours), another software 

utility then converted all of the individual maps into TSV (tab-separated variable) 

image files from the proprietary Link-Isis format. This format is a general imaging 

format that can be imported into ImageJ, a powerful free image processing and 

analysis software developed by the National Institute of Health (NIH) that will be 

discussed in more detail later in this section.  

 

For EPMA-WDS the software developed (AutoProbe) was even more 

robust. Working through the 5500 and 5600 Tracor-Northern hardware and that 

proprietary software/language, AutoProbe coordinated the collection from a 

Windows PC over a serial connection of large arrays of points (<100,000). 

AutoProbe assembled all these points into x-ray maps in real-time. In addition to 

the four elemental x-ray maps, a specimen current map was also constructed. 

The probe was equipped with four spectrometers thereby enabling the 

simultaneous collection of four different elements. We therefore collected calcium 

(Ca), silicon (Si), chlorine (Cl), and sulfur (S). Large collections took > 30 hours 

due mainly to the limited speed of the serial connection, the PDP11 hardware 

used in the Tracor-Northern stand-alone, and the 100 ms. dwell-time minimum 

limit built into the proprietary 5500 software. Specific key operating details used 

for both instruments during all collections are summarized in Table 1.  

 

ImageJ software was used extensive throughout the project to process the 

large amounts of image data into quantitatively meaningful images and graphics. 

Software macros developed by Rick Diest were therefore created to facilitate the 

import and conversion as well as the assemblage of the data from the Link-Isis 

system and from the AutoProbe software. 
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Table 1 Operating parameters used for SEM and EPMA 

 

SEM-EDS       

         Probe Current: 9 nA (~20% dead time) 

         Resolution: 26.78 pixels/mm (~37 μm effective step) 

         Accelerating Voltage: 10 kV 

         Dwell Time: ~20 ms (rough approximation) 

         Avg. Collection Time: 17.5 sec/mm2 

         Detector Mode: “Optimum acquisition rate” 

         Speedmap frames: 40 

EPMA-WDS       

         Probe Current: 200 nA 

         Resolution: 10 pixels/mm (100 μm step) 

         Accelerating Voltage: 15 kV  

         Dwell Time: 200ms 

         Avg. Collection Time: 86.1 sec/mm2 

 

 

 The best opportunity for quantifying the concentration of a single element 

in an extremely complex and heterogeneous matrix like cementitious materials 

using the SEM or the EPMA is to construct what is known as a calibration curve, 

or series tallying the x-ray counts from standard samples with various known Cl 

concentration levels. Ideally to construct such a calibration curve, standard 

samples, exactly the same in composition to the experimental to be investigated, 

are prepared with increasing known amounts of the analyte (Cl in this case). 

Fortunately, with cement and concrete mixes, this is easily possible.  

 

This was indeed the approach implemented by Mori et al. and was 

therefore adopted for this study. Mori et al. also made a very strong case that 

separating the paste pixels from those that are aggregate, and conducting the 

study profiling only the paste for Cl, yielded Cl concentration results more closely 

matching to those generated by wet chemistry. This follows from the primary 

assumption that Cl diffuses essentially only through the paste, and paste makes 

up only a fraction of most concrete. Therefore, the x-ray maps constructed using 
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e-beam methods were composed largely of pixels corresponding to large (rock) 

and small (sand) aggregate. Since this rock and sand aggregate contain very low 

amounts of Cl, if any, their corresponding pixels have very low if not zero Cl x-ray 

counts. If these Cl x-ray counts are included as well as the counts from paste 

pixels to calculate the average Cl x-ray counts for a given area of concrete, the 

average can be significantly impacted by the inclusion of large numbers of 

essentially zero Cl x-ray counts from aggregate pixels. This influence on the 

average Cl x-ray counts translates into potentially erroneous calculated values of 

the Cl concentration compared to wet chemistry measurements.  

 

We therefore developed a paste-discrimination method based on imaging 

using a concept called pixel-masking or simply masking. In imaging, a mask can 

either preserve all pixels under the mask or exclude them; in this study the pixels 

under the mask we kept while all pixels not covered by the mask were set to a 

non-numeric value (not a number, NaN) which is analogous to turning these 

pixels off so that they do not show in the image and are excluded from any 

measurements made from the image. The paste-only mask must be generated 

from one of the other elemental maps or from some combination of them. An 

image with high contrast for paste pixels compared to aggregate is needed. 

Ideally, a mapped element other than Cl is found mainly in the paste at some 

relatively constant high level compared to the aggregate. This way, paste pixels 

that contain low levels or zero Cl are legitimately included in measurements and 

averages.  

 

Calcium and silicon are not suitable because they are both found in paste; 

sulfur and aluminum (Al) however met this criterion. The S maps were therefore 

used to generate a paste-only mask for the probe data, and the Al for the SEM-

EDS data. Thus, the data for the maps is obtained from the paste only. All pixels 

corresponding to fine and coarse aggregate are removed by the masking 

technique. 
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An example of the masking strategy described above can be seen in 

Figure 11; two areas of a concrete sample are shown: high and low Cl 

concentration. Our observations are that the polishing doesn’t appear to smear 

anything since great care is taken during the polishing by cleaning the surface 

regularly with blasts of compressed air. In samples were a clear gradient is 

observed with wet chemistry, that gradient is also observed with our 

methodology. If there was smearing we should expect to see a random 

distribution of chloride or a homogenization of the chloride distribution on the 

surface. Even if there was smearing on the surface the data does not come from 

the surface, it comes from a several microns volume under the surface. 

 

Figure 11 Example of the masking strategy showing high and low [Cl] areas   

 

               The calibration curves from the concrete samples were derived using a 

slight modification on the procedure that was applied to the standards. The 

paste-discriminated x-ray map was segmented into rectangular chunks, each 

representing a particular depth range from the exposed surface.  These chunks 

were then quantified to allow plotting of X-ray intensity as a function of depth.  To 

create a calibration curve, these depth/x-ray intensity data were plotted against 

the corresponding depth/Cl concentration data (from wet chemistry) provided by 

the FDOT and a linear regression equation was calculated relating X-ray intensity 

to Cl concentration. 



 39 

CHAPTER 4 
FINDINGS 

 

Summary of Data 

 

A summary of data can be found in Appendix 1. 

 

Presentation of Results 

 

Using EPMA-WDS paste-only Cl maps, master calibration curves for the 

1-series and CFS standards were created (Figure 12); the corresponding Table 4 

shows the raw data used to construct the curves as well as some descriptive 

statistics.  

 

Figure 12 EPMA-WDS master calibration curves using paste-only Cl maps 

for the 1-series and CFS standards 

 

Using SEM-EDS paste-only Cl maps, master calibration curves for the 1-

series and CFS standards were created (Figure 13); the corresponding Table 5 

shows the raw data used to construct the curves as well as some descriptive 
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statistics (Table 6). The linear model fitted well all data sets collected on both 

instruments as evidenced by the coefficients of determination all nearly 1.   

 

 

Figure 13 SEM-EDS master calibration curves using paste-only Cl maps for 

the 1-series and CFS standards 

 

 

The following figures 14 to 19 show the linear and logarithmic calibration 

curves corresponding to samples B-15, E-15 and I-15 using tables 7, 8, and 9. 

Figures 20 and 21 (master calibration curves) combine correspondingly the linear 

and log curves for samples B-15, E-15 and I-15. 
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Figure 14 Calibration curve (linear scale) using paste-only Cl maps for the 

B-15 sample 

 

 

Figure 15 Calibration curve (log scale) using paste-only Cl maps for the B-

15 sample 
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Figure 16 Calibration curve (linear scale) using paste-only Cl maps for the 

E-15 sample 

 

 

Figure 17 Calibration curve (log scale) using paste-only Cl maps for the E-

15 sample 
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Figure 18 Calibration curve (linear scale) using paste-only Cl maps for the 

I-15 sample 

 

 

Figure 19 Calibration curve (log scale) using paste-only Cl maps for the I-

15 sample 
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Figure 20 Master calibration curves (linear scale) using paste-only Cl 

maps for samples I-15, E-15 and B-15 

 

 

Figure 21 Master calibration curves (log scale) using paste-only Cl maps 

for samples I-15, E-15 and B-15 
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The following figures 22 to 36 show the results corresponding to the 

analysis of the concrete samples corresponding to diffusion experiments 

conducted at the FDOT-SMO. 

 

The results corresponding to EPMA-WDS are presented for each 

experimental sample in Figures 22, 27, and 32 showing a specimen current 

image of the area being analyzed, a binary (black and white) paste pixel mask, 

and a paste-pixel-only Cl map. As explained previously, the specimen current 

provides an image that combines topography and average atomic number 

variations across the area analyzed. The rectangular areas of contrast 

correspond to separate data collection sessions. The paste pixel-only Cl map 

shows the distribution of Cl with a color code scale corresponding to the average 

count/s/nA that can be converted to concentrations using the regression 

equations obtained for the standards.  

 

Figures 23, 28, and 33 correspond to the concentration depth profiles of 

samples B-15, E-15 and I-15. Figures 24, 29, and 34 correspond to the 

normalized depth profile obtained through the measurements done with EPMA-

WDS. The intensities corresponding to the concentrations were normalized and 

are expressed in arbitrary units (AU). It is important to clarify that no correction 

factor was used to normalize the data. The normalization was achieved by taking 

the highest concentration or counts measured and dividing that set of data by 

that number. So it is not matrix or mix specific. 

 

Figures 25, 30, and 35 correspond to the BSE imaging maps, binary paste 

pixel map, and paste pixel-only CL maps. The paste pixel-only Cl map shows the 

distribution of Cl with a color code scale corresponding to the average counts 

that can be converted to concentrations using the regression equations obtained 

for the standards. Finally, figures 26, 31, and 36 correspond to the concentration 

depth profile obtained through the measurements done with SEM-EDS. Again, 

the intensities corresponding to the concentrations were normalized and are 
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expressed in arbitrary units (AU). 

 

 

Figure 22 Specimen current image, pixel mask, and Cl x-ray map corresponding 

to sample B-15 using EPMA-WDS. Color code corresponds to Cl average 

count/s/nA 
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Figure 23 Concentration depth profile of sample B-15 with WDS 
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Figure 24 Normalized depth profile of sample B-15 with EPMA-WDS 
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Figure 25 BSE imaging map, pixel mask, and Cl x-ray map corresponding to 

sample B-15 using SEM-EDS. Color code corresponds to Cl average counts 
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Figure 26 Normalized depth profile of sample B-15 with SEM-EDS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 51 

 

Figure 27 Specimen current image, pixel mask, and Cl x-ray map corresponding 

to sample E-15 using EPMA-WDS. Color code corresponds to Cl average 

count/s/nA 
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Figure 28 Concentration depth profile of sample E-15 with WDS 
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Figure 29 Normalized depth profile of sample E-15 with EPMA-WDS 
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Figure 30 BSE imaging map, pixel mask, and Cl x-ray map corresponding to 

sample E-15 using SEM-EDS. Color code corresponds to Cl average counts 
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Figure 31 Normalized depth profile of sample B-15 with SEM-EDS 
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Figure 32 Specimen current image, pixel mask, and Cl x-ray map corresponding 

to sample I-15 using EPMA-WDS. Color code corresponds to Cl average 

count/s/nA 

. 
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Figure 33 Concentration depth profile of sample I-15 with WDS 
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Figure 34 Normalized depth profile of sample I-15 with EPMA-WDS 
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Figure 35 BSE imaging map, pixel mask, and Cl x-ray map corresponding to 

sample I-15 using SEM-EDS. Color code corresponds to Cl average counts 
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Figure 36 Normalized depth profile of sample I-15 with SEM-EDS 

 
 
Method of Analysis 

 

 Let us examine the probe calibration data. The y-intercepts for the linear 

models (the counts per second per nano amperes (c/s/nA) that would be 

observed for a sample with 0 ppm Cl) are 0.231 and 0.214 c/s/nA for the 1-series 

and CFS series standards respectively. According to Mori et al., the limit of 

detection for probe method is defined as: 

 

Np – Nb > 3  (1) 

 Where Np is the count rate observed for the peak and Nb is the count rate 

measured of the background;  is the standard deviation of Np – Nb. The 

standard deviation of Np – Nb using the first samples in each series (no added Cl) 

is 0.006. Three times this value is 0.018 indicating that the limit of detection 
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(LOD) is < 0.005 wt. % Cl (5 ppm); this value is likely not a conservative enough 

estimate for the LOD. The average standard derivation for all the average Np – 

Nb was 0.125, multiplied by three is ≈0.39 indicating and LOD of ≈300 ppm for 

our probe method. Given the fact that a simple t-test of the mean count rates 

obtained for standards 1 and 3 in both standard sets indicates that the count 

rates are significantly different (higher for 3 than 1) and the data presented 

above, we placed the LOD conservatively at the nominal LOD of 0.01 wt. % (100 

ppm) for elements quantified using a microprobe. 

 

The LOD for SEM-EDS is much higher than for EPMA (WDS). SEM-EDS 

offers a rapid mapping but not the sensitivity for the lower concentrations, while 

EPMA (WDS) offers a lower LOD. These techniques are complementary not 

substitutable. SEM-EDS has a 1000 ppm LOD, unlike EPMA (WDS) that can go 

as low as 100 ppm. In the case of cement and concrete samples the wet 

chemistry analysis is the proper method for evaluating absolute concentrations 

below 300 ppm. 

Interestingly, Mori et al. define the variance of Np – Nb as:  

 

V = Np + Nb (2) 

 

Applying the assumption that Np  Nb for elements present in trace 

concentrations yields: 

 

V = 2Nb (3) 

 

Hence the variance for 1 series and CFS series are 0.462 and 0.428, 

respectively, which yields a standard deviation of 0.68 and 0.65. Three times 

these amounts is ≈2 (≈3000 ppm) which is a tremendously over conservative 

estimate of the LOD of the probe method.  

 

  The simple criterion of three times the standard deviation of the 



 62 

background was applied to help estimate the LOD for the SEM-EDS x-ray 

mapping. This was done because maps of the background around the Cl peak 

could also be collected and analyzed on the standard samples at same time as 

all the other elements of interest. Results of the background study are 

summarized in Table 4.  

 

If we take 0.72 as the average standard deviation of the background, three 

times this value would be 2.16; this value is however in conflict with the 

regression equation and reality as it yields a negative calculated Cl 

concentration. In fact, both regression equations yield negative values for the 

concentration of Cl for standard 1 and 3 in both sets. Both equations appear to 

generate non-negative values for standard 5 (≈500 ppm).  

 

Applying the more stringent criterion that Np – Nb > 3σ sets the LOD for 

the SEM-EDS mapping method ≈ 0.1 – 0.2 wt. % (1000 – 2000 ppm), a nominal 

LOD for EDS detection. Both regression equations fit the data very well, 

evidenced by both coefficients of determination > 0.95, so an LOD of 1000 ppm 

for the method is a conservative estimate and the LOD could arguably be less 

than that to a lower limit of 500 ppm. 

 

The average error estimated for the Da values calculated with EDS data 

compared with the Da values obtained through wet chemistry is 6.8%. The 

corresponding error for Da values obtained with WDS data is 4.4%. 
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CHAPTER 5 
DISCUSSION 

 

Validity of hypothesis 

 

An inspection of the weight percent concentration maps showed that the 

e-beam microanalysis methods used (SEM-EDS and EPMA-WDS) over-

predicted the absolute concentration of Cl when compared with the values 

obtained by the wet chemistry method. However, when we normalized the data 

(microanalysis and wet chemistry), there is an excellent correspondence in the 

depth profile curves. The calculated Da values from microanalysis data is on 

average within 7% error for EDS and 5% for WDS compared to the value given 

by the wet chemistry method.  

 

It is important to note that the estimates of Da look good, but the simple 

Fickian solution fit is ruled by the large value part of the profile, thus, the low 

concentration data could be removed and the same value could be obtained. If 

the goal is to look for potentially important benefits from chloride binding, the low 

concentration tail of the curve near the ~300 - 600 ppm threshold value – is 

critical. There is where the SEM method begins to lose accuracy while EPMA 

remains valuable. 

 

Factors affecting the results 

 

The close match of the curves after normalization indicated that there was 

a correction factor or offset that needed to be applied to the calibration equation 

that could then predict more accurately the wet chemistry values. Thus, we 

developed a method to estimate such correction factor using the data from the 

CFS series and found that it properly corrected the predicted concentration 

values to match quite closely the wet chemistry values. 

 

We developed a calibration curve from I-15 and used it to quantify the 
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other samples. This resulted in a much better match to the wet chemistry data 

which indicates that I-15 is a more suitable calibration standard than either of the 

standard series. Hence the choice of calibration standard can strongly impact the 

calculated absolute concentrations derived from X-ray maps.  

 

An important point to explain is the e-beam time required for the analysis 

of the samples using EDS and WDS. The speed of collection and assembly of 

large scale images with BSE is critical to reduce the analysis time (x-ray intensity 

detection and processing). Once a BSE map is collected, regions of aggregate 

and paste can be clearly differentiated. Thus, an alternative to measure large 

scale areas is the collection of data along single linescans that go across paths 

that consist mainly of paste (as indicated in figure 26). These linescans 

perpendicular to the exposed surface can minimize the amount of data collected 

and the time required for quantitative analysis. 

 

 
 

 
Figure 37 Proposed linescans across paste on sample B-15 
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Implications 

 

The data and results strongly suggest that the e-beam X-ray mapping 

methods successfully adapted and developed by MAIC for both the SEM and 

EPMA instruments can be easily/readily used by FDOT-SMO to support and/or 

supplant currently employed methods for quantitative chloride profiling of 

concrete. These X-ray mapping methods provide a wealth of new information 

heretofore unavailable to FDOT-SMO that can now by applied to aid FDOT-SMO 

evaluation of concrete structure durability and remediation. Large-scale X-ray 

mapping could potentially help with the more efficient execution of FDOT-SMO’s 

mission. While full maps might be cost prohibitive (8 h and $300 for wet 

chemistry analysis compared to 8 hours and $450 for SEM-EDS analysis), the 

benefits such as Chloride distribution maps, sample not getting destroyed, 

thousands of data points, and automated analysis, are clear. In any case the 

proposed less costly route of linescans should be further explored. 
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CHAPTER 6 
CONCLUSIONS 

 

Conclusions from the study 

 

We  sought to adapt and reproduce the methods and results described by 

Mori et al. above, and in a review [7], with the instrumentation available at MAIC 

for our work for FDOT-SMO. Additionally we developed a large scale x-ray 

mapping method with SEM instrumentation available at MAIC. At the present 

time, we know of no study like this for SEM. Thus, not only were we able to 

produce results mirroring to that of Mori et al. (on both instruments), but we also 

developed another paste-aggregate discrimination technique based on imaging 

as well as a standardless analysis method to determine Da based on normalized 

[Cl] data fit to Fick’s 2nd diffusion law. Calculated Da from data generated on both 

instruments agrees within 10% error to the calculated Da values determined for 

the same samples by FDOT-SMO using the wet chemistry data/methodology.  

 

 We matched within a 7% or better error the diffusion coefficients 

calculated from wet chemistry data. In spite of the fact that the calibration curves 

over-predicted the concentration values, this did not impact the accuracy of the 

estimation of diffusion coefficients. Given that the estimation of diffusion 

coefficients was the end goal of the wet chemistry analysis, the presented 

methodology achieved the evaluation of the most sought parameter. 

 

Standardless SEM-EDS estimation of diffusion coefficients was the most 

expeditious method of sample analysis. If the interest was focused on the 

estimation of absolute concentrations, corrected calibration curves using 

standards and EPMA were the most appropriate route. 
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Summary of Conclusions 

 

MAIC has successfully adapted and developed an automated e-beam X-

ray mapping method for cementitious samples using both the SEM and EPMA. 

This X-ray mapping method can provide quantitative microscopic images of 

chlorine distribution over a large area of a sample using as well as distribution 

data for other elements simultaneously.  The Da for chloride diffusion in concrete 

samples can potentially be determined more rapidly with X-ray mapping while 

preserving samples for future analysis and minimizing hazardous waste 

generation. This study is a strong independent confirmation of the utility and 

applicability of e-beam X-ray mapping for organizations such as FDOT-SMO to 

use in the monitor, study, repair and improvement of cement and concrete 

materials and structures. 

 

Recommendations 

 

A new instrument with a configuration tailored to the needs of this 

methodology is recommended. A standard system comes with an x-ray detector 

for EDS and four WDS spectrometers at a price on the $1M range. However, 

EDS and only two spectrometers are necessary with one crystal each (for Cl and 

S) if the system will be a dedicated system to perform the analysis of Cl. This 

gets the price of a new system significantly lower. A used system, with a few 

years of use, is also a good alternative and reduces even further the cost of the 

instrument. 

 

Sample preparation is fundamental in the generation of good data. The 

FDOT-SMO and the MAIC do not have in-house the capabilities to do a sample 

preparation comparable to that done by APS. Thus, it is recommended to either 

develop in-house the sample preparation method or negotiate a high volume/ 

long term arrangement with APS so sample preparation costs are minimized.  
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Appendix 

 

1) Summary of data: 

 

Table’s columns headings: 

 

Bkg Mean:  Calculated average background (not characteristic) x-ray counts 

generated from all pixel collection areas 

 

Bkg StdDev: Standard deviation of the background mean 

 

[Cl] (ppm) CFS Cal/[Cl] (ppm) I-15 Cal: Calculated chlorine concentration 

using either the calibration equation derived for the CFS standard series of 

from the I-15 sample gradient 

 

EPMA Cts Std Dev (Raw Data): Standard deviation of the mean counts 

 

EPMA Cts Std Err of Mean: Standard deviation of the mean counts divided by 

the number of collection points/pixels 

 

Depth: For chloride determination, the sample is cut into slices parallel to the 

chloride-exposed surface (physical slices for wet chemical analysis, virtual for 

e-beam analysis). For the wet chemical analysis, the thickness of each slice 

was ~6.35mm, 1/4” (Except for the first slice). The listed value is the depth 

into the sample of the bottom of each successive slice. 

 

Depth (Tables 9,11,13,15,17,19): Distance into the sample normal to the 

chloride-exposed surface. 

 

FDOT Wet Chem (ppm): results of wet chemistry analysis measured in ppm 
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FDOT Wet Chem (wt%): results of wet chemistry analysis measured in weight 

percent 

 

Mean Cts – EPMA: Average of all characteristic Cl x-ray counts divided by the 

count time (dwell time) and the measured specimen current for each collected 

point/pixel (counts/s/nA) 

 

Mean: Calculated average characteristic Cl x-ray counts from all collected 

pixels 

 

Normalized Intensity (AU) (Tables 8,10,12,14,16,18): A min-max 

normalization of the raw ppm data to simplify input to the curve fitting program 

while preserving the relation of data points to one another.  The resulting 

values fall in the computationally convenient range [0,1] 

 

Where I is the entire set of raw intensity values and Ix is the intensity  value (in 

arbitrary units, AU) corresponding to a particular depth 

 

Normalized Intensity (AU) (Tables 9,11,13,15,17,19): Normalized intensity for 

chlorine concentration calculated using curve fitting 

 

SEM Cts StdDev (Raw Data): Standard deviation of the mean counts 

 

SEM Cts StdErr of Mean: Standard deviation of the mean counts divided by 

the number of collection points/pixels 

 

StdDev: Standard deviation of the mean 
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Wet Chemistry (ppm): Chloride concentration in ppm determined by the 

FDOT-SMO wet chemical method for each successive slice 

 

WDS (Cts/s/nA): The calculated average from all paste pixels in the nearest 

1mm virtual slice thickness (generated from the image processing) of the 

characteristic Cl characteristic x-ray counts divided by dwell time and 

specimen current 

 

Raw ppm: Chloride concentration in ppm determined by the FDOT-SMO wet 

chemical method for each successive slice 

 

Raw counts: The calculated average from all paste pixels in the 1mm virtual 

slice thickness (generated from the image processing) of the characteristic Cl 

characteristic x-ray WDS counts divided by dwell time and specimen current 

(counts/s/nA) 

 

Tabulated Data: 

Table 2: Data corresponding to the mixes of the series 1 of cement-chloride 

standards  

Series 1 Chloride Standards (w/c = 0.35) 

Series 
1 

(Mix)  
Mix Cl

- 
Design 

Cl
- 
ppm 

added 
Weight 
Cl

-
 (g) 

Weight 
NaCl 
(g) 

Cement 
Weight 

(g) 

Water 
Weight 

(g) 

1-1 Control 
Background 

(Bg) 
0 0.0000 0.0000 296.296 103.704 

1-2 50 ppm Bg + 50 ppm 50 0.0200 0.0330 296.272 103.695 

1-3 100 ppm Bg + 100 ppm 100 0.0400 0.0659 296.247 103.687 

1-4 200 ppm Bg + 200 ppm 200 0.0800 0.1319 296.199 103.670 

1-5 400 ppm Bg + 400 ppm 400 0.1600 0.2638 296.101 103.635 

1-6 600 ppm Bg + 600 ppm 600 0.2400 0.3956 296.003 103.601 

1-7 800 ppm Bg + 800 ppm 800 0.3200 0.5275 295.906 103.567 

1-8 1000ppm Bg + 1000ppm 1000 0.4000 0.6594 295.808 103.533 

1-9 2000ppm Bg + 2000ppm 2000 0.8000 1.3188 295.319 103.362 

1-10 4000ppm Bg + 4000ppm 4000 1.6000 2.6377 294.342 103.020 

1-11 6000ppm Bg + 6000ppm 6000 2.4000 3.9565 293.366 102.678 

1-12 8000ppm Bg + 8000ppm 8000 3.2000 5.2753 292.389 102.336 

1-13 10000ppm 
Bg + 

10000ppm 
10000 4.0000 6.5941 291.412 101.994 
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Table 3 Data corresponding to the mixes of the CFS series of cement-

chloride standards 

 

 

 

 

CFS Series Chloride Standards (w/c = 0.35) 

CFS 
(Mix) 

Mix 
(ppm) 

Cl
- 

Design 

Cl
- 

ppm 
added 

Cl
-
 (g) NaCl (g) 

Cement 
(g) 

FlyAsh 
(g) 

Sand (g) 
Water 

(g) 

1 Control 
Backgro

und 
(Bg) 

0 0.0000 0.0000 354.610 70.922 424.681 149.787 

2 50  
Bg + 50 

ppm 
50 0.0500 0.0824 354.581 70.916 424.646 149.775 

3 100  
Bg + 
100 
ppm 

100 0.1000 0.1649 354.551 70.910 424.611 149.763 

4 200  
Bg + 
200 
ppm 

200 0.2000 0.3297 354.493 70.899 424.541 149.738 

5 400  
Bg + 
400 
ppm 

400 0.4000 0.6594 354.376 70.875 424.401 149.688 

6 600  
Bg + 
600 
ppm 

600 0.6000 0.9891 354.259 70.852 424.261 149.639 

7 800  
Bg + 
800 
ppm 

800 0.8000 1.3188 354.142 70.828 424.121 149.590 

8 1000  
Bg + 

1000pp
m 

1000 1.0000 1.6485 354.025 70.805 423.981 149.540 

9 2000  
Bg + 

2000pp
m 

2000 2.0000 3.2971 353.441 70.688 423.281 149.293 

10 4000  
Bg + 

4000pp
m 

4000 4.0000 6.5941 352.272 70.454 421.880 148.800 

11 6000  
Bg + 

6000pp
m 

6000 6.0000 9.8912 351.102 70.220 420.480 148.306 

12 8000  
Bg + 

8000pp
m 

8000 8.0000 13.1883 349.933 69.987 419.080 147.812 

13 10000  
Bg + 

10000p
pm 

10000 10.0000 16.4853 348.764 69.753 417.680 147.318 
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Table 4 EPMA/WDS calibration curves raw data for the 1-series and CFS 

standards 

 

 

 

 

 

Table 5 SEM-EDS calibration curves raw data for the 1-series and CFS 

standards 
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Table 6 Results of the background analysis of SEM-EDS data 

 

 

 

 

 

Table 7 Data corresponding to the wet chemistry and WDS analysis for 

sample B-15 calibration curve 

 

Derived Calibration B-15 

Depth (cm) 

Wet Chemistry 
(ppm) 

WDS 
(Cts/s/nA) 

0.3175 9561.754386 8.075 

0.9525 6639.649123 5.493 

1.5875 3017.631579 2.805 

2.2225 792.6315789 0.966 

2.8575 68.94736842 0.249 
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Table 8 Data corresponding to the wet chemistry and WDS analysis for 

sample E-15 calibration curve 

 

Derived Calibration E-15 

Depth (cm) 

Wet Chemistry 
(ppm) 

WDS 
(Cts/s/nA) 

0.3175 12243.50877 12.016 

0.9525 5224.736842 4.535 

1.5875 1774.824561 1.946 

2.2225 92.36842105 0.27 

2.8575 35.61403509 0.227 

 

 

Table 9 Data corresponding to the wet chemistry and WDS analysis for 

sample  I-15 calibration curve 

 

Derived Calibration I-15 

Depth (cm) 

Wet Chemistry 
(ppm) WDS (Cts/s/nA) 

0.3175 9765.964912 8.386 

0.9525 3760.789474 3.018 

1.5875 355.5263158 0.348 

2.2225 31.49122807 0.261 

2.8575 32.80701754 0.267 
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Table 10 Raw and normalized data corresponding to the wet chemistry 

analysis and the WDS analysis of sample B-15 for concentration depth profile 
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Table 11 Data corresponding to the normalized WDS intensities used for the 

depth profile fit curve for sample B-15 
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Table 12 Raw and normalized data corresponding to the wet chemistry 

analysis and the WDS analysis of sample E-15 for concentration depth profile 
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Table 13 Data corresponding to the normalized WDS intensities used for the 

depth profile fit curve for sample E-15 
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Table 14 Raw and normalized data corresponding to the wet chemistry 

analysis and the WDS analysis of sample I-15 for concentration depth profile 
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Table 15 Data corresponding to the normalized WDS intensities used for the 

depth profile fit curve for sample I-15 

 

 

 

 

 

 

 

 

 

 



 82 

Table 16 Raw and normalized data corresponding to the wet chemistry 

analysis and the EDS analysis of sample B-15 for concentration depth profile 
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Table 17 Data corresponding to the normalized EDS intensities used for the 

depth profile fit curve for sample B-15 
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Table 18 Raw and normalized data corresponding to the wet chemistry 

analysis and the EDS analysis of sample E-15 for concentration depth profile 
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Table 19 Data corresponding to the normalized EDS intensities used for the 

depth profile fit curve for sample E-15 
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Table 20 Raw and normalized data corresponding to the wet chemistry 

analysis and the EDS analysis of sample I-15 for concentration depth profile 
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Table 21 Data corresponding to the normalized EDS intensities used for the 

depth profile fit curve for sample I-15 

 

 

 

2) FDOT SEM 6400 Mapping Guide 

 Load sample 

 Ensure that the microscope X-Y stage axes are centered (X: 25 mm, Y:35 

mm) 

 Turn on Deben Sprite Two Axis Stage Controller using red power switch in 

the rear of the Deben labeled box on top of the SEM housing 
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 Bring down the Sprite control module with display and joystick and confirm 

that the coordinates displayed match with those shown on each axis’ 

mechanical counter 

 Bring up SEM system to operating conditions 

 Select proper “job” in the Link ISIS software 

o The map data will be saved to the job’s directory but only 1000 map 

group images may be saved per job, so it is wise to open 

Speedmap (grid icon on X-Ray Analysis window) and use the 

“Open or Delete a Spectrum” dialog to confirm that sufficient space 

is available prior to beginning any automated collection, creating a 

new job if necessary 

 Turn on attached picoammeter and set scale properly then set the probe 

current as desired for consistent collection results, using the far right white 

button above the five fault lights on the SEM table itself to toggle the 

Probe Current Detector 

o Note that the filament typically takes 45-60 minutes to stabilize, and 

may take considerably longer if it has been recently replaced; wait 

for stability to get the best mapping results 

 Open the Isisbin/wxAStg/wxAStg.exe program 

o Click the Edit->Insert Pattern button to generate a rectangular grid 

with the appropriate stage coordinates 

o Click the File->Start Run button to bring up the run dialog 

 Open the ISIS Auto program 

o Click the Edit->Auto Setup button and click the No X-ray Acquisition 

setting at the top, Beam mode: Scan, Imaging: Acquire X-ray maps 

o Click the record button to generate the total number of points 

indicated on the wxAStg run dialog 

 Return to wxAStg and click the Make Ready button to move the stage to 

the starting position 

 Return to ISIS Auto, click Edit->Select All then click the Play button, select 

Single Auto Run and click Start 
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 Within a few seconds return to wxAStg again and click the Start Run 

button 

 The two programs should now be in synchronized operation 

 Your automated collection should be underway and the stage should 

move automatically between the grid points indicated in wxAStg 

 When finished, center the stage and turn off the Deben Sprite Stage 

Controller again using the switch in the back then shutdown the SEM as 

normal 

o Be sure to switch the ISIS job back to “Job number 1” for the next 

user 

 To batch convert your map data files from proprietary ISIS format into 

standard tab separated variable (TSV) you may use the Edit->Process 

Data dialog in wxAStg and select the proper ISIS job directory 

o Note that at the time of writing the wxAStg Generate Montage 

functionality is incomplete and should not be used, the ImageJ 

macros are instead provided separately 

 

3) Loading FLEXTRAN Program on TN-5500 System 

This procedure usually only needs to be redone if the TN-5500 has been 

rebooted since the last program load. 

 On the TN-5500: 

o Press ESC to exit TASK if necessary so you are at a basic 

FLEXTRAN prompt 

o If an asterisk appears in the upper left, press CTRL+A (toggle echo) 

then press ESC again 

o Flip the small black switch in the back to the UP position (terminal 

input enabled) 

 Open Windows Explorer and navigate to the AutoProbe\CLI folder 

 Run AutoProbe_CLI.exe 

 At the command prompt  on the PC: 

o Type init 3 
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 The number (3 here) is the COM port that is being used, 

same as in HyperTerminal connection 

o Type sendfile FT_LScan_Fast.flxt 50 250 

 You should see the commands being sent on the TN-5500 

screen and the PC command prompt will say “Done” when 

finished 

o Type quit 

 

4) Running FDOT samples with AutoProbe 

 Load sample into system 

 In the menu use Insert->Rectangle to specify a new region of interest 

(ROI) to collect 

o A rectangle will be created with default parameters.  To change its 

position and parameters, click on its name (default: “New Rect”) in 

the Objects list on the upper right and input new values in the table 

that appears in the lower right.  Please make sure that X1 < X2 and 

Y1 < Y2 before you start a collection or odd things might happen 

o You may insert as many ROI objects as desired for the run, but one 

works fine for all the samples so far 

 In the menu, go to Tools->Calibrate Z 

o This process will take 3 points and mathematically determine a 3D 

plane containing them, approximating a perfectly uniform flat 

surface. The plane will then be used to link any X, Y position to a 

corresponding Z height 

o Choose any 3 points that appear to be as well polished as possible 

and enter their X,Y,Z coordinates using the optical microscope to 

determine Z.  The points being spread out across the ROI will give 

the best results 

 Pre-Execute Checklist 

o Beam current, spot size, e-beam focus, etc. all set as desired for 

run 
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o The TN-5500 is sitting at FLEXTRAN prompt and echo is off, that 

is no asterisk appears when you press ESC 

o The small black switch beside the terminal and keyboard 

connections on the back of the TN-5500 system flipped in the UP 

position (terminal input enabled) 

o Confirm that each object has the proper parameters set 

 In the menu click Run->Execute 

 


